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System Requirements
Windows 98, NT, 2000, XP
100MB of free disk space
512MB of RAM
Revision History
v1.0 - 4/18/2010 - Initial release
Known Issues
Windows Vista and Windows 7 require running the software in administrator mode so that it can write to the disk
Licenses
Demo: one-time 14 day trial, no data export, no settings save/load
Full: node-locked
Contact
Website: http://www.sziengineering.com
Information request: info@sziengineering.com (please use “NASBA Analysis” in the subject line)
Intro
The NASBA Analysis tool allows you to take fluorescence data from any temperature-regulated fluorometer and calculate a Time-To-Positivity (TTP) for the S-curve. By using the signal conditioning and analysis procedures, an initial concentration of the target RNA can be estimated. The software automates many of the steps required to calculate TTPs and can work with up to 4 independent fluorescence channels to generate TTP ratios and even calibration data.
The data flow can be divided into several distinct operations: loading, cropping, filtering, analyzing, plotting, searching, and modeling.
In the following document, certain items on the user interface are denoted with the following special modifiers:
	() – units. Ex: min, sec

[] – options. Ex: Raw, Cropped
{} – control type Ex: command button, field
Loading section
This tool accepts comma-separated values (CSV) formatted data files with data in column format (i.e. a time columns, a fluorescence column, and a temperature column). Some fluorometers generate this data natively, while others will require some minimal use of Microsoft Excel or other spreadsheet software. Please consult your spreadsheet software vendor's documentation on how to do this. In order for the software to load the data, it will need to know the column format. This is accomplished by building a parser string. Once a string is entered in the "columns" field, it will turn red or green, depending on whether it's a valid string.
Columns {field}
The parser string must be in the following format: timescale,#NASBA_columns|#neg_columns:Atime,A,Atemp,Btime,B,Btemp,NA,NAtime,NAtemp,NB,NBtime,NBtemp
timescale = multiplication factor for all time columns to convert to mS (ex: if the time columns contain fractional minutes, use 60000)
#NASBA_columns = total number of columns in the main data file (should be >0 and not exceed 12)
#neg_columns = total number of columns in the optional separate non-target file. #NASBA_columns+#neg_columns should not exceed 12
Xtime = column number where the time stamps for channel x fluorescence and temperature data are located. If a time column is set to 0, that channel is ignored
X = column number where the fluorescence data for channel X is located. If a fluorescence column is set to 0, that channel is ignored
Xtemp = column number where the temperature data for channel x is located. If a temperature column is set to 0 on an active channel, no temperature data will be processed
Any unused fields should be set to 0. Trailing zeroes can be omitted from the parser.
A non-target (negative) reaction data can be part of the main file or loaded separately. It should have the same timescale as the main file.
The NA and NB column locations are relative to the file they come from. If a separate file is used, then the indices start from 1, otherwise they start from #NASBA_columns+1. The time and temperature columns can be shared amongst many channels, but not across files. If unsure of what the formats look like, look at some of the parser defaults. Several sections of the adjustment tables may be grayed-out as a result of the parser and the load button for the negative data may change color to indicate the software's expectation.
Parser defaults […] {drop-down menu}
Some parser defaults are included in the interface and can be accessed by clicking the down arrow button next to the columns field. If you write a custom parser, you can save it to this quick list by selecting "Add to temporary list". You will be prompted to give it a name and it will be added to the list. If you save your settings, any parsers in the temporary list will be added when reloading the settings file.
Integration time (mS) [1~65535] {field}
This is the time between data points that the software will calculate. If the integration time is less than the spacing between data points in the file, then a cubic spline will be used to extrapolate the data. The software will attempt to generate data down to time 0 and up to the maximum time for all enabled channels. For data outside of the range for the channel, the data at each extreme will be copied. This method will also synchronize the data for all channels and create an even sampling rate for the filtering process. If you wish to keep your data resolution, set the integration time to the spacing between data points in the original file. Setting the integration time higher will result in data being dropped. If you wish to decimate your data, provision are made in the analysis section.
Time data [index/real (min)] {toggle button}
If the time column is an integer index and you wish to keep the data resolution, use index mode. In this case, the timescale will be set to the integration time.
Null value (raw) and Saturation value (raw) {field}
If the fluorometer outputs data in blocks and marks the end as invalid by either setting the fluorescence value to 0 or a high value, you can use these two settings to detect that condition and ignore the end of the data. Data must meet null<data<sat.
Load negative {command button}
If the parser string has enabled the separate negative file, this button will be yellow and expecting data. Load this before loading the main data.
Load filename {command button}
This is where the main analysis process starts. Once you select a file to load, the software will load both the negative (optional) and main data files into memory. The loader will check if the number of columns matches and if the time columns contain sequential and unique data. It will then trim and extrapolate the data according to your settings.
Analysis [auto/manual] {toggle button}
If this is enabled, the software will proceed through the rest of the analysis automatically, based on the current settings. This is useful if tweaking parameters and you wish to see how the different stages are affected. The rest of the sequence is color-coded so that you can easily follow through.
Filter section
This section will allow you to filter out the noise in the data. Although your data may look clean to the naked eye, it can contain spurious noise that will make TTP searching very hard. The digital filter is a low-pass linear phase delay filter with variable order and cut-off frequency (you will not see any "ringing" once the S-curve shows the amplification). Automatic delay compensation is also included.
Filter window (sec) {field}
This represents the fastest frequency that is allowed to pass through the filter. Setting the filter to a low value will remove the high-frequency noise associated with the fluorometer sampling hardware only, while setting it higher will also remove low-frequency noise that comes from the temperature regulation of the sample during amplification. Do not set the window to more than the rise time of the S-curve or you will attenuate it.
Filter order [0~20] {field}
This will allow you to set the strength of the filter for frequencies outside of the pass-band. A higher order filter will further reduce high frequency spikes without changing the filter window. Use a higher order if you have high spurious spikes in the data. Set it to 0 to disable filtering
Delay compensation {toggle button}
The filter, as any other, will cause signal delay. This can introduce large errors in the TTP if not removed. Leave this box checked to remove the filter delay for the crop step.
Filter {command button}
Perform the filtering and calculate the filter delay
Filter delay (samples) {field}
Output from the automatic filter calculation. If you feel that this value is off, you can use the arrows to adjust it manually
Crop section
This section allows you to remove sections of the data before the enzyme reaction starts. This is useful to synchronize all of the fluorescence channels. The cropping data table also allows you to remove data from the end of the reaction in order to exclude it from the search algorithm.
Start temperature (°C) {field}
This is the temperature at which all time stamps for the active channels will be reset to 0. Set it to 0 to disable cropping
Crop {command button}
Perform the automatic data cropping
Cropping data {table}
Manually adjust the cropping of each active channel. This is also useful for synchronization if you can see that the enzyme kinetics are delayed in one of the channels
Analysis section
This section generates the 4 data streams that are used by the search section.
Decimation type [none, drop, average] {drop-down menu}
This control lets you set the method for decimation. "None" will not decimate the data, "drop" will simply drop unused data, and "average" will average all of the data points that will be replaced by 1. This is useful to decrease the differential peak sensitivity and make it easier to plot exported data.
Resolution (sec) {field}
The new sampling resolution after decimation. This will be approximate as the decimation has the be monotonous across the whole dataset
Normalization time (min) {field}
Time which to normalize the data for normalized and relative search. It is also the minimum time for a successful TTP.
Pos Endpoint Time (min) {field}
Time which to set the positive endpoints of all enabled channels to 1 in relative search mode. It is also the maximum time for a successful TTP
Subtract negative [None, Normalized, Relative, Proportional] {drop-down menu}
Allows you to select how channel NA’s data will be subtracted from the rest of the channels. This is used to remove a slightly increasing linear trend due to enzyme kinetics. Relative mode requires channel B and NB to calculate the gains.
Subtract negative data {table}
This table shows the gain used on channel NA’s data before being subtracted from each individual channel. You can tweak each value manually and evaluate the result visually and with the help of the flatness output. The flatness is measured after the positive endpoint time and will indicate if the data is trending positive or negative overall.
Analyze {command button}
Perform the calculations to generate the search data and populates the normalization data table
Normalization data {table}
Allows you to manually adjust the normalization and positive endpoint time for each active channel
Plot section
Two plots are available for visualizing the data. The raw data graph lets you see the raw data and the results of the filtering and cropping steps. The processed data graph will let you see the output of all 4 analysis data streams and the cropped data. Each graph has editable axes to specify a region of interest. You can zoom in by holding ctrl+left click, drag with ctrl+shift+left click, or reset the zoom with ctrl+space. The legend area allows you to change each plot attribute by right-clicking on it.
Top plot [Raw, Cropped] {drop-down menu}
Allows you to select between raw and cropped data. A draggable white marker is available to make visual observation easier.
Overlay filtered on raw {toggle button}
When ticked will display a fat overlay of the filtered data on either raw or cropped data. You can use this to see the effects of the filter and the area of rejection after cropping.
Bottom plot dropdown menu [decimated, differential, normalized, relative] {drop-down menu}
Allows you to select between decimated, differentiated, normalized, and relative data. 3 markers are available on the plot: the blue for TTP of channel A, the red for TTP of channel B (both of these snap to the data), and a yellow for the search value.
Overlay cropped on decimated {toggle button}
When ticked will display a fat overlay of the cropped data only on the decimated plot. This allows you to evaluate the effects of the decimation on resolution reduction and the negative trend subtraction
White cursor X and Y {field}
This is the location of the white cursor on the raw data graph.
Search section
This section allows you to search for the TTP of Chan A and Chan B based on the selected TTP search type. The TTP ratio will also be calculated. The outputs are color-coded to indicate success and the processed data graph cursors can be used to examine the data manually.
TTP search type [linear intercept, differential peak, normalized, relative] {drop-down menu}
Allows you to select the TTP search algorithm that you would like to use. It also selects the plot that will be processed when the search command button is executed for manual cursor adjustment. All TTP search values have to be between the normalization time and positive endpoint time to be considered valid.
normalized search  = multiplies all active channel by a gain so that at normalization time, the fluorescence is reading 1 (basic) and finds the first occurrence of the search value
relative search = applies a gain and offset to all active channels so that at normalization time, the fluorescence is reading 0 and at the positive endpoint time, it's reading 1 (medium) and finds the first occurrence of the search value
differential peak search = takes the differential of the data and finds the first peak after normalization time above the search value of at least the specified peak width (medium)
linear intercept = using the same differential peak settings, it estimates a linear model at the peak point and calculates the linear intercept with the value at normalization time (advanced)
Search value {field}
Sets the search value for the selected search type. It is indicated by the yellow cursor on the graph. You can manually drag the cursor to set the value as well.
Peak width (min) {field}
The minimum peak width that the differential and linear intercept searches will look for. Setting this value too high can result in the peak being shifted or not found altogether.
Use actual slope {toggle button}
In linear intercept mode, if checked, will use the actual peak of the differential data as the slope of the line model. If unchecked, it will use the calculated peak as the slope.
Search {command button}
Executes the automatic TTP search. If valid TTP are found, the cursors are moved to those location and the values are displayed in green. Otherwise, the values are red. If either marker is red, the TTP ratio is also red. All 3 TTP displays are yellow if the markers were adjusted manually.
TTP Chan A (min) and TTP Chan B (min) {field}
Location of the blue (A) and red (B) cursors on the processed data graph.
TTP ratio {field}
Shows the calculated TTP ratio of the two markers and also allows you to set a custom ratio for use in the modeling section
Modeling section
This section allows you to build a logarithmic model from known concentrations and calculated TTPs so that an estimate of the sample concentration can be made. Several automations are available to build calibration data from raw data and evaluate the quality of the model based on the software parameters.
Calibration data {table}
This table can contain up to 6 data points for the model. The intent is to use 3 different concentrations, bracketing the sample to be estimated, and provide duplicates for each. The table entries are color coded, depending if they’re empty, invalid, or valid. At least 3 valid entries are needed to build the model.
Auto Cal {command button}
Allows you to load a cal file that contains up to 6 pairs of known concentration values and data filenames. Once the cal file is loaded, the software turns on the auto analysis and processes each one of the known concentration data files with the current settings. The calibration table entries are cleared and updated with the results of each one of the files if the TTP ratio was found. The model is then built and the R2 value is calculated.
The cal file format is CSV: concentration, filename
The filename of the data is relative to the directory of the cal file. 
Cal file {field}
Shows the current cal file that generated the calibration data table values. If you modify the table manually, this field will be cleared.
Model {command button}
Calculates the coefficients automatically, using the least squares method from the calibration table.  
Logarithmic model coefficients {field}
You can edit the model coefficients manually, if you wish, and a new R2 value is calculated from data in the table.
R2 value {field}
It indicates the goodness of fit for the model to the calibration data. A value of 1 indicates a perfect model. Acceptable values are >0.9
Estimate {command button}
Calculates the estimated concentration from the current TTP ratio, based on the current model (the model is solved for x internally).
Concentration {field}
Estimated concentration output from the program (i.e. the pot of gold).
Menu bar section
The menu bar has several useful shortcuts, such as launching this help file. Other functions can only be accessed through there, which are described below.
Exporting
Exporting the processed data is important for archival purposes and publishing of results.  Once your data is processed, go to File>Export and select a folder to write the data files to. All streams than have been processed to that point will be written to the disk in comma-separated value format. Each file is titled according the stream that produced it.
Files will contain a title row that is identical to the filename, a header row that contains the column descriptors, and 12 data columns (4 timestamps, 4 fluorescence, and 4 temperatures). 32000 data points will be exported, regardless of the amount of data in the original set (this is the maximum for Microsoft Excel).  To plot the data simply select all the columns you want to see and insert a scatter plot (the file is formatted so that the graph will name everything automatically for you).
View mode
Until you are comfortable with the analysis process, you should run the software in beginner mode. This setting prevents you from changing some of the advanced controls until you are ready to explore them. The program defaults will give generally give good results, but you can change the mode anytime. This setting will be saved in the settings file.
Settings
Saving your settings is important for archival purposes of the data and for your convenience. You can easily save and reload setting files by going to the Settings menu. If there is a “default.ini” settings file in the home directory, it will be loaded automatically when the program starts up.
License Info
You can access all of the licensing functions and see the current status in this window.
To license the full version of the software, please go to “Help>License Info”, fill out the form and click the “Register” button. A registration file will be created for you, containing your contact information and the hardware ID on which you will use the software. Simply send us the registration file (located in the main program directory) by e-mail and we will contact you for payment information. Once payment is processed, you will receive a license number that will only work for that registration file, which you should leave in the main program directory. You can apply the license by going to “Help>License Info” and clicking the “Enter license” button. Your license will be verified against the registration file (whose hardware ID must match your computer) and the license will be saved for future reference.
E-mail your registration file to license@sziengineering.com and include “NASBA Analysis” in the subject line for the fastest processing.
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